
GW-UNTERRICHT Nr. 120 / 2010  GW UND INFORMATIK 

 

GW und INFORMATIK 

Hartwig Hitz und Alfons Koller 

hartwig@hitz.at, PH-Niederösterreich,  Institut für Geographie und Regionalforschung, Universität Wien, 1010 Wien 
gwu@ph-linz.at, PH-Linz, Bischöfliches Gymnasium Petrinum, 4040 Linz 

Neben der Softwarebeschreibung des virtuellen Globus Marble finden Sie in dieser Ausgabe sechs 
Vorschläge für Karten, Diagramme und Webseiten mit ein paar methodischen Tipps zum Unter-
richtseinsatz. Rückmeldungen dazu sind herzlich erwünscht! 

1 Softwarebeschreibungen  

Marble – Desktop Globe 

Torsten Rahn & Inge Wallin et al. (2010)  
The Marble Project, Version 0.10.3.- o. O.,  
Web: edu.kde.org/marble (12.12.2010) 

Lizenz 

Der Marble – Desktop Globe ist frei verfügbar (GNU Lesser General Public License - LGPL). Alle Be-
nutzer sind auch eingeladen zu (Weiter-)Entwicklern dieses Geobrowsers zu werden. 

Voraussetzungen 

• PC (mit Windows oder Linux-Betriebssystem) oder Apple MacIntosh 

• Internetzugang für Installation und Download der Daten (Wenn diese einmal lokal gespeichert 
sind, kann dort auch ohne Internetzugang gearbeitet werden.) 

Installationsprogramm / Start 

Der Marble – Desktop Globe wird installiert, indem von der Web-Seite 
http://edu.kde.org/marble/download.php Marble-Qt aufgerufen wird. Der im Moment aktuelle Di-
rektlink für Windows lautet: http://developer.kde.org/~tackat/marble/marble-setup-0.10.1.exe . 

Auf dieser Web-Seite stehen Downloadversionen von Marble für MS Windows, Mac OS X und KDE 
(Linux) zur Verfügung. Weiters ist Marble in den meisten Linux-Versionen entweder bereits vorin-
stalliert (z. B. Edubuntu) bzw. kann nachinstalliert werden. Für Tests (unter Linux) steht außerdem 
eine Live-CD zur Verfügung, die keinerlei Installation am PC erfordert.  

Die Installation, die etwa 45 MB Festplattenspeicher benötigt, läuft automatisch ab; im Nachhinein 
wird der digitale Globus sofort gestartet bzw. kann er unter Windows über die KDE Marble - Gruppe 
im Programme-Menü gestartet werden. 
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Inhalte 

Dass ein virtueller Globus und ein digitaler Atlas nicht immer Google Earth bzw. Google Maps hei-
ßen muss, beweist das Marble-Projekt mit seinem Marble - Desktop Globus. 

Nach dem Programmstart erscheint ein zweigeteilter Bildschirm. Neben der Menü- und Statusleiste 
und dem Karten-/Globus-Fenster, das den Großteil des Bildschirmes einnimmt, ist im linken Teil ein 
Navigationsfenster mit fünf verschiedenen Inhalten bzw. Reitern zu finden. Die Texte sind in engli-
scher Sprache gehalten. 

 

Abb. 1: Marble - Desktop Globe: Übersicht 
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Von Beginn an sind folgende Ansichten (Map Views) verfügbar, wobei für jede selbstverständlich 
eine passende Legende angezeigt werden kann: 

   

 

   

Abb. 2: Sieben vorbereitete Ansichten in Marble - Desktop Globe 

Neben der 3-dimensionalen Globus-Darstellung stehen auch zwei 
verschiedene 2D-Kartendarstellungen zur Verfügung (darunter 
eine Mercator-Projektion). Diese eignen sich insbesondere für 
nicht-globale, also größer maßstäbige Darstellungen. 

   Abb. 3: Wechsel zwischen 2D- und   
   3D-Darstellungen 

Über den Legend-Reiter kann nicht nur die Legende betrachtet, 
sondern können auch die einzelnen Ebenen der Karte ein- und 
ausgeblendet werden. 

Der Reiter Navigation dient dazu, innerhalb der Karte zu navi-
gieren, was aber auch direkt in der Karte mit der Maus möglich ist. 
Weiters kann nach geographischen Namen gesucht werden, die 
in der Marble-eigenen Datenbank bzw. in OpenStreetMap 
enthalten sind. 

Weiters steht über den Reiter Routing eine Routenplanung für 
Autos, Fußgänger oder Radfahrer zur Verfügung, die auf 
OpenRouteService zurückgreift und eine Internetverbindung vor-
aussetzt. 
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Möchte man auch die Online-Services Fotos, Wetter oder Wikipedia verwenden (In der Menüleiste: 
View > Online-Services > ….), so ist dafür klarerweise eine Verbindung zum Internet notwendig, da 
nur aktuelle Wikipedia-Einträge oder Wetterdaten (View > Clouds) Sinn machen.  

Darstellung thematischer Karten 

Sollten einem die mitgelieferten Karten nicht genügen, so können weitere Karten aus dem Web 
geladen werden (File > Download maps > auswählen).  

Der Verlag Ed. Hölzel geht noch einen Schritt weiter und baut seinen aktuellen Geothek-Weltatlas 
auf Marble auf, d. h. neben den vorhin erwähnten Basiskarten stehen dann in Marble zahlreiche 
weitere thematische Karten aus dem Kozenn-Atlas zur Verfügung. Klimakarte, Vegetationskarte etc. 
werden so auf einem virtuellen Globus sichtbar.  

 

Abb. 4: Thematische Karten am Marble-Globus, z. B. Vegetationskarte aus dem Kozenn-Atlas 

Weiters verfügt die Atlas-Version von Ed. Hölzel auch über eine Schaltfläche, mit Hilfe derer man 
von der Globus-Ansicht auf Hölzels physische Karten wechseln kann, die mit zahlreichen Klimadia-
grammen (inklusive Tabelle mit den Werten für jedes Monat) und Fotos angereichert sind. 

Neben der Darstellung der Erde verfügt Marble – wie auch Google Earth – über eine Monddarstel-
lung, was Marble auch für den Physikunterricht interessant machen könnte. 
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Diese Software ist ein KDE Education Projekt. Es zählt zu den freien Bildungsressourcen (Free Educa-
tional Ressources). Ursprünglich stammt diese Entwicklung aus der Linux-Entwicklergemeinde, für 
die der K-Desktop entwickelt wurde. Sie läuft nun aber auch auf anderen Oberflächen (z. B. Win-
dows). 

Schuleinsatz 

Warum kann man in der Schule in Erwägung ziehen, neben dem allseits bekannten Google Earth einen 
zweiten virtuellen Globus zu verwenden? 

1. Zum einen können auf ihm sehr einfach thematische Karten (aus dem Kozenn-Atlas von Ed. 
Hölzel) „montiert“ werden, vergleichbar dem digitalen Globus von Westermann, der allerdings 
nur für deutsche Diercke-Atlanten zugänglich ist. Wie alle Globusdarstellungen, sind die feh-
lenden Verzerrungen bezüglich Lage, Größe und Form Vorteile gegenüber 2D-Weltkarten. Sie 
prägen somit ein anderes Kartenbild in den Köpfen der Betrachter/innen. 

2. Die allgemeine Diskussionen über Google Street View hat in Deutschland und Österreich viel 
Skepsis gegenüber einem umfassenden Web-Service-Anbieter zutage gebracht. Eine Garantie 
der langjährigen freien Verfügbarkeit fehlt, die Transparenz der Datenauswahl ist ungeklärt. 
Marble Desktop Globe wäre eine frei verfügbare Alternative. 

3. Neben der frei verfügbaren Software (Freeware) eines kommerziellen Anbieters werden Open-
Source-Software und die GNU Lesser General Public Licenses zum Thema im Unterricht. Erstere 
bedeutet, dass der Code dieser Software offen, also öffentlich zugänglich, ist. Er wird von meh-
reren Programmierer/innen weiterentwickelt, er hat also nicht eine/n eindeutig feststehenden 
Autor/in, sondern ein permanent wachsendes Entwicklerteam. Die Lizenzen selbst sollen die 
Freiheit garantieren, alle Versionen eines Programms mit anderen zu teilen und zu verändern. 
Es darf somit frei kopiert und verändert werden, sowie müssen veränderte Versionen frei wei-
tergegeben werden. (Peter Gerwinski (2007) GNU General Public License , Dt. Übersetzung.- 
Boston, Web: http://www.gnu.de/documents/gpl-3.0.de.html 12.12.2010) 

 

Welche Themen und Lernziele werden bei der Verwendung virtueller Globen im Unterricht angespro-
chen? 

1. Neben der Darstellung thematischer Inhalte bietet der virtuelle Globus (im kleinen Maßstab) 
Übersichtskarten und Satellitenbilder in naturnahen Farben. Über die Karten von Open Street 
Map können mit demselben Geo-Browser auch großmaßstäbige Darstellungen bis auf Orts- 
und Straßenniveau (mit Hausnummern und Fußwegen) angezeigt werden. Somit liefert diese 
Arbeit wertvolle Beiträge zur Orientierungskompetenz. 

2. Das Verständnis von Kartenprojektionen mit dem Wissen um die unvermeidbaren Verzerrun-
gen in Lage, Größe und Form kann durch den Wechsel der drei Darstellungsformen (3D-
Globus, zwei 2D-Karten) geschult werden. 
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3. Weiters wird die Sonnenbestrahlung der Erde in der Satellitenbildansicht dargestellt. Damit 
lässt sich für jedes Datum und für jede beliebige Uhrzeit die Sonnenbestrahlung der Erde er-
kennen. Die Schrägstellung der Erdachse wird berücksichtigt, und somit die Bestrahlung auch 
richtig auf der Erdoberfläche dargestellt, die Erdachse selbst ist aber (derzeit noch) immer senk-
recht, also nicht wie bei einem realen Globus schräg gestellt. Der Hinweis auf die reale Bewe-
gung der Erde um die Sonne darf keineswegs entfallen. 

Kontakt 

Über eine Mailingliste und ein Forum können Fragen an die Nutzer-Community gestellt und dort 
diskutiert werden. Wie bei Web-2.0-Software üblich, gibt es keine direkte Hotline oder einen An-
sprechpartner. 

Bezugsquelle 

Web: http://edu.kde.org/marble 

2 Eine Auswahl interessanter Web-Links 

Geocube – www.geo-cube.eu 

Geocube ist ein Würfel mit neun Bildern auf jeder seiner 
sechs Seitenflächen. Er bietet damit  

• 54 Bilder, die für das Fach Geographie stehen können,  

• 54 Themen, mit denen sich Geographen 
und Geographinnen beschäftigen, oder 

• 54 Themen, die im Unterricht von Geo-
graphie und Wirtschaftskunde zur Spra-
che kommen können.  

 
Sie sind in folgende Kapitel gegliedert: 
• Die Erde aus allen Blickwinkeln 
• Zusammenleben 
• Schrumpfender Planet 

• Faszinierender Planet 
• Unsere Welt erforschen  
• Angewandte Geographie 
 
Der Geocube lädt ein, geographisch zu for-
schen, unseren Planeten Erde kennen zu lernen, Interessantes und Spannendes zu entdecken. 
Geocube ist ein Projekt von Herodot und Eurogeo, zwei europäischen Geographie-Netzwerken. He-
rodot wurde ursprünglich in Österreich gegründet, um das Web für den GW-Unterricht zu nutzen 
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(Herodot – Using the Web in Teaching Geography), dann von Karl Donert als Netzwerk der universitä-
ren Geographie etabliert, um den Austausch über das Verständnis von Geographie in Europa vo-
ranzutreiben und Lobbying für das Fach zu betreiben. Eurogeo ist die europäische Gesellschaft der 
Schulgeographen, welche versucht europaweit Informationen über den Geographieunterricht 
auszutauschen und Lobbying zu betreiben. 

Lassen Sie Ihre Schüler/innen mit Geocube experimentieren. Sie sollen sich für eine Seite entschei-
den, mehrere Themen auswählen und sich informieren. Texte, Bilder und Videos geben Einblicke in 
faszinierende Themen unserer Erde. Lassen Sie die Schüler/innen  
• von ihren Entdeckungen berichten,  
• eine Idee vorstellen oder 

• eine Mindmap dazu verfassen. 
 

Bilingualer GW-Unterricht mit Google Büchern 

Web: 
books.google.at/books?q=related:ISBN0748760741&id=DLnwwbbPHIC&source=gbs_similarbooks
_s&cad=1 

Für Englisch als Arbeitssprache und bilingualen 
Unterricht bietet die Vorschau in den Google-
Büchern interessante Unterrichtsmaterialien. Die-
se Integration fremdsprachiger Texte (Bilingualer 
Unterricht) und das Unterrichtsprinzip EAA (Englisch als Arbeitssprache) erweitern den Erfahrungs-
schatz unserer Schüler/innen im GW-Unterricht. 

Neben den wenigen englischen Publikationen in der Schulbuchliste bzw. deutscher Verlage grei-
fen Lehrer/innen dabei gerne auf Schulbücher aus dem angelsächsischen Sprachraum zurück. Die 
Google Bücher bieten dazu einen weiteren Zugang. Vergleichbar dem Durchblättern in einer 
Buchhandlung ist eine große Zahl von Seiten direkt abrufbar und kann somit im Unterricht einge-
setzt werden. Sie sollen einen Einblick vermitteln und zum Kauf der Bücher motivieren. 

Was spricht für den Einsatz von fremdsprachigen Texten? 
• Der methodische Einsatz österreichischer Schulbücher folgt sehr oft dem Prinzip „Lesen – un-

terstreichen – lernen“. Sie bieten „geglättete Texte“ und rezeptives Wissen. Schulbücher aus an-
deren Kulturräumen bieten häufiger Primärliteratur an. Die Schüler/innen werden aufgefordert, 
den Text zu erschließen, ihn in eigenen Worten zusammenzufassen und auf Anwendungsgebie-
te umzusetzen. Sie werden mit fremdsprachigen Originalquellen konfrontiert und machen die-
se zum gewohnten Lesegut. 

• Fremdsprachige Quellen versuchen Fächergrenzen zu öffnen. Sie bringen eine Fremdsprache 
ins Spiel, diese wird sukzessive zur Selbstverständlichkeit. 
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Ein Blick auf Österreichs Landwirtschaft  

Karten und Diagramme der Statistik Austria geben Einbli-
cke in die Situation und Entwicklung der österreichischen 
Landwirtschaft. Die Fertigkeit des Kartenlesens, ein kriti-
sches Hinterfragen der Darstellung und die Bereitschaft, 
auch im Alltag Karten zu nutzen, zählen zur geforderten 
Kartenkompetenz unserer Schüler/innen. 

Datenquelle www.statistik.at/dynamic/wcmsprod/idcplg?IdcService= 
GET_NATIVE_FILE&dID=84754& dDocName=053429 /ohne Leerzeichen/ 

Thesen zur Auswahl  eduweb.schule.at/wp/epilot/wp-content/uploads/2010/11/ thesenlandwirt-
schaft.pdf  /ohne Leerzeichen/ 

 
Einen Einblick in die österreichische Landwirtschaft zu gewinnen, ist ein Thema in der 3. Klasse 
HS/AHS (7. Schulstufe). Die Statistik Austria bietet dazu Diagramme und Karten an, welche von 
Schüler/innen gelesen und interpretiert werden können. Die Thesen bieten dazu einen Einstieg 
und eine Auswahl, die Fragen leiten zu kritischem Lesen an. Auch viele topographische Begriffe 
kommen dabei zur Sprache. 

Methodisch könnten folgende Zugänge gewählt werden: 
1. Gemeinsames Bestimmen, was in der Karte bzw. im Diagramm dargestellt wird. 

2. Ableiten einzelner Aussagen aus der Grafik. 

3. Bestimmen der Regionen, in denen Merkmale gehäuft auftreten oder völlig fehlen, auch im 
Vergleich mit einer topographischen Karte. 

4. Vermuten, warum Häufungen bzw. das Fehlen gerade dort auftreten;  
mit Einbeziehen von Hintergrundinformation. 

5. Vergleich mehrerer Karten und Ableiten gemeinsamer Aussagen. 

6. Ableiten von Konsequenzen für die betroffene Bevölkerung. 

 

Homepage der Bundes-Arge GW AHS  −  bundesarge.gwk.at 

Die Arbeitsgemeinschaft aller Landesargeleiter an AHS in Österreich betreibt eine gemeinsame 
Web-Seite. Auf ihr finden Leser/innen:  

• Kontaktpersonen in den einzelnen Bundesländern 

• Newsmeldungen zum Fach GW 
• Unterrichtsimpulse und –materialien, beispielsweise Vorschläge zur Neuen mündlichen Matura 

in GW 
Ein Blick darauf lohnt sich! 
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Wikimedia Maps  −  commons.wikimedia.org/wiki/Category:Maps 

Freie Karten, Abbildungen und Fotos mit gesicherten Rechten bietet Wi-
kimedia an. Die Autor/innen haben ihre Nutzungs- und Weitergaberechte 
jeweils fixiert, sodass vieles für Lehre und Unterricht gratis und legal 
übernommen werden kann. Werfen Sie einen Blick auf diesen Fundus:  

• Kartographie: Karten in verschiedenen Projektionen, Globen 

• Diagramme zum demographische Übergang, atmosphärischen Zirku-
lation 

• Karten zu Klimazonen, von ausgewählten Regionen, aus unterschiedlichen Zeitepochen 
• Luft- und Satellitenbilder ausgewählter Orte 

• etc. 
 

Linz im Spiegel der Statistik  

Web: www.schuleundwirtschaft.at/SundW.nsf/0/ 16A9E77DFA5 
E1EB5C125774A002FFCAF/$file/GESAMT%20Linz%20Statistik%20inkl%20Deckblatt.pdf 

Kartenlesekompetenz ist ein zentrales Ziel des GW-Unterrichts. Da-
zu gehört auch die Fertigkeit und die Kompetenz, Diagramme und 
Statistiken zu lesen, zu interpretieren und kritisch zu hinterfragen. 
Eine Publikation der oö. Wirtschaftskammer bietet dazu eine Gele-
genheit, bei der auch über die Wirtschaftsstruktur der Stadt Linz Interessantes erfahrbar wird. 

Auswahl möglicher schulrelevanter Grafiken mit Impulsfragen für Schüler/innen: 
• S. 16: Wieviele Menschen arbeiten bei den Linzer Unternehmen? Sind alle am Standort Linz tä-

tig? 

• S. 17: In welcher Sparte arbeiten die meisten Lehrlinge? Welchen Eindruck liefert das Dia-
gramm? Woran liegt das? 

• S. 20: Was sagt das Diagramm über den Tourismus in Linz aus? Worin könnte der Anstieg von 
2009 begründet sein? 

• S. 12: Weshalb übertreffen zwei andere Bezirke die Landeshauptstadt Linz bei der Zahl der 
Nächtigungen? 

• S. 22: Was macht die überwiegende Zahl der dt. Touristen/innen in Linz? 
• S. 24: „Die Bevölkerung blieb im letzten Viertel des Beobachtungszeitraumes so ziemlich gleich.“ 

– Kannst du dieser Aussage zustimmen? Warum? Warum nicht? 

• S. 26 stellt ein schwierig zu lesendes Diagramm dar. Diskutiere es mit deinem/r Lehrer/in. 
 
Weitere interessante Diagramme: S. 27, 28, 29, 34, 38, 39, 40, 48 und 50. 
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